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Introduction 

 This manual is aimed at facilitating the application learning process, with the development of a step-

by-step project and in different stages. In the Reference Manual, you will find complete information 

about all aspects not addressed herein. We assume that the CAD is installed correctly and that, in relation 

to the TCP-MDT, the Installation Guide instructions have been followed. For all the examples we 

assume that the installation directory is C:\Program Files\Aplitop\MDT85, and the project 

directory is C:\MDT85 Projects. 

 To make explanations easily understood, a series of screenshots have been included, in which the 

AutoCAD version is shown. The aspect offered by the remaining CAD-supported versions is similar, and 

its operation is the same. 

In order to show the capacity of the program for both small and large jobs, sixteen different 

examples are included. To perform some of them, you must have the Professional version or the 

Surveying module, as detailed below. 

Standard Version 

1. In the first one, a small survey of approx. 100 points is considered, on which point management 

operations and definition of break lines will be carried out. 

2. In the second example, triangulation, contour, profile operations, etc. are executed, as well as the 

application of different tools on the profiles already generated and drawn 

3. The third example addresses two different states of the terrain, the process necessary to perform the 

calculation of volumes by difference of profiles and grid difference. 

 

Professional Version 

4. This is a larger work (approx. 750 points), in which virtually all functions are executed from previously 

prepared files, and is primarily intended for the design of grade lines, superelevations, widenings, road 

sections, etc. 

5. Once the section in the previous paragraph has been defined, we can define a more complex section. In 

this case, we are going to deal with a section in which we will make use of the roadbed surface of an 

existing road. 

6. In this exercise, just like the previous one, the final objective is the construction of a road, but in this 

case, the platforms will be built from the existing information in the drawing plan. Likewise, a section 

will be built from the elevation of a previously drawn section in CAD. 

7. In this section, we will address everything related to the definition of the roadbed layers and their cubic 

measurement. 

8. In this exercise, the modified terrain is obtained as well as the volumes, the setting out of lines and 

realistic presentations, taking number four as an example. 

9. The creation of platforms is performed, as well as the execution of earthworks by knowing the level of 

grading or contacts with the terrain, as well as the drawing of solids and rendering. 

10. Several tools are used in the construction, an alignment from tracing elements (straight lines, contours 

and clothoids), to later convert it to an axis ready to be used in other commands. 

11. Practical application of Road Intersection, both in horn-type connections and road links. 

 

Surveying Module 

12. An example where the surveying module operation is detailed, with the conversion of a file from an 

electronic book, and the calculation of its coordinates. 

13. An exercise where we use more advanced methods for calculating coordinates. In this case, we will 

perform calculations by traverses and networks. 

14. An exercise where data transformations are addressed. 

15. A practical example where the most important functionalities of the MDT Images module are 

described, which are applied to the topography. 
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Professional Version 

16. BIM models. Import and export of IFC files. 

17. Networks. Project for the design of rainwater and sanitation networks. 

18. Work units. Definition and generation of reports. 
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Exercise 1. Point Management 

 A construction company orders a plot survey, in which earthworks will be carried out, consisting of 

an embankment that will house a parking lot and subsequently the landscaping of the NW area. This area 

will be filled with remains of the cleared land. 

First, a survey of the potentially affected area is carried out in its original state. Consequently, the 

calculation process with any program provides us with a file of coordinates, which we will import with 

the corresponding tool. 

In order to issue a comparative plan of cross sections with the Administration project, we will 

execute the Digital Terrain Model, by using the drawing elements (polylines) that connect the topographic 

points as break lines. Once the DTM is prepared, we will process the cross section cuts of the plot starting 

from a N.S. longitudinal axis bearing identical characteristics to that of the project and with a 2-meter 

equidistance of said cuts to compare exhaustively (by excess) with the original project that they presented 

at every 10.00 meters. This process will provide us with a cross section file. 

Finally, after making another data sample of the modified terrain, we will obtain cuts thereof by 

using the same axis, and we will calculate the earthwork between both terrains.  

We describe the step-by-step process, throughout the first exercises of this manual. 

Program Start 

 Click on the MDT 8 icon located on the Windows desktop or run the MDT icon located in the MDT 

group created when the program was installed. 

Once executed, the CAD will automatically load and the MDT application will be automatically loaded 

along with its menu and toolbars. 

Creating a Project 

 By creating a project, a better tracking of MDT-generated files is achieved. By executing the 

Project > New menu, the program requests a file name to create a new project. We can enter the name 

Tutorial01 in directory C:\MDT85 Projects\Tutorial01. Then, the project window pops up. 

 

Importing Points 

 We start from a file of point coordinates generated by any topography program, by means of manual 

data entry or electronic notepad. In our case, the file is called DEMO1.PUN, and it contains 101 points. 

We list below a fragment of this file, whose fields are: point number, X coordinate, Y coordinate, Z 

coordinate and code. 
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2 257.836 264.781 46.570   

3 258.914 274.491 46.760   

5 260.736 284.925 47.130   

6 262.893 293.434 47.430   

8 265.817 301.429 47.560   

9 270.104 311.112 47.850   

10 272.797 315.505 48.180   

11 278.382 323.371 49.050   

12 282.897 331.671 49.700   

14 284.979 338.837 50.290   

15 285.349 346.624 50.910   

16 287.658 346.885 51.140 ALB S 

17 292.947 347.153 51.120 ALB  

18 296.339 347.070 51.120 ALB  

19 296.223 353138 51.120 ALB  

20 284.724 373.268 52.160 CMI  

21 286.749 372.258 51.240 ALB S 

22 291.682 372.405 51.120 ALB  

23 295.453 368.948 51.120 ALB  

24 288.523 343.006 50.600 AES S 

26 290.512 339.895 50.940 AES  

27 290.035 334.929 51.260 AES  

28 285.462 332.820 49.960 AES  

29 293.558 336.082 48.280 BT S 

 These points have been coded in the field, so that part of the planimetry can be drawn automatically. 

The relationship between these codes and the entities to be drawn is determined by the Codes Database, 

which can be viewed by executing the option Points > Codes > Codes Database (or Points > 

Operations > Codes Database). Press the Cancel button. 

 

 To import the points, choose the menu option Points > Import (or Points > Creation > Import). 

Select the NXYZ format within the Generic category, and set it as a Space separator. Activate the 

Classify Point by Levels and Draw from Codes boxes. Select scale 500.  

 

Press OK. After validating the dialog box, choose file DEMO1.PUN within directory C:\MDT85 

Projects\Tutorial01. 



 

User Manual 7 

 The points defined in the file will be represented on screen. The polylines and blocks corresponding 

to the point codes will also be drawn, according to the definition of the Codes Database. Check the layers 

that were created automatically. 

 

 To check the imported data, we will first execute the Points > List Points command (or Points > 

Operations > List). Using the selection system through the dialog box, we choose All, and the dialog box 

displays the points list with point number expression, level, X coordinate, Y coordinate, Z coordinate and 

code. 

 

 In the list, you can check that there are three point levels: Fill, Break and Information. 

Change Format 

 One possibility offered by the program is to represent each point differently depending on its level 

or group to which it belongs. Run the Points > Modify points > Change Format command (or Points > 

Edition > Change > Change Format). In the dialog box, select Overall and All. 

 

 Press the button ... and another dialog box is displayed that facilitates the setting of the 

representation of points by levels. 
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 We change the number of decimals to 3 and activate the Draw in 3D box. 

Definition of Break Lines 

 Due to the circumstances produced in the field data sample process, it is almost impossible to 

encode all points in an orderly manner, so that it is necessary to resort to other commands in the program 

to complete the assembly of the works. 

First, we will draw a path that has constant width and from which we have taken only one side. 

Zoom in on the lower left corner of the window. 

Now select the command Break Lines > Displaced Parallel (or Break Lines > Creation > 

Displaced Parallel). Select the Points mode, type in the name BRK-LINES in the Layer box and 

activate the Create Points box, also assigning the Break level and the BRK-LINES code. Finally, in 

Heights, select the Repeat option and press OK. 

 

Then, you will see in the command area: 

First point: 

With the mouse, name positions close to points 112, 2, 3, 5, 6, 8, 9, 10, 11, 12, 14, 15 and 20 in 

this sequence. We can use the transparent commands zoom, frame, etc. In case of error, enter D to undo 

the last vertex. After the last point press <Enter> and when the program asks for an orientation, click with 

the mouse on a point to the left of the newly created line. Continue with data input: 
 

Separation: 5 <Enter> 

13 points created 

 We see that a new polyline has been drawn in the BRK-LINES layer to the left of the original. In 

addition, each vertex has created a point with the same dimension as the corresponding original points. 
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 We zoom in again by extension. Likewise, we will manually complete the lines that configure the 

basins of the pool wall. Select Break Lines > Point numbers (or Break Lines > Creation > Numbers). 

Instead of selecting one of the existing layers, we will create a new one. Press the New button. 

 

 For the layer name, type BRK-LOW_WALL, press the Name button and select the Blue color. 

Press OK and then OK again. 

 

 Enter the following sequence of point numbers: 

 
First point: 99 <Enter> 

First point: 21 <Enter> 

Another point: <Enter> 

First point: 92 <Enter> 

Another point: 22 <Enter> 

Another point: <Enter> 

First point: <Enter> 

Command: 

 

 Repeat the process by creating the BRK-HIGH_WALL layer, with Blue color and the following 

sequence of point numbers: 

 
First point: 99 <Enter> 

Another point: 24 <Enter> 

Another point: <Enter> 

First point: 28 <Enter> 

Another point: 12 <Enter> 

Another point: <Enter> 

First point: <Enter> 

Command: 
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Finally, we will draw the low-slope lines with the same command, but choosing the existing 

LOW_SLOPE layer. Link points 97, 29, 48 with the previous procedure and then 97 and 98. 

Thus, the settings regarding the drawing of structure and break lines are completed. Save 

drawing as Demo1.DWG in directory C:\MDT85 Projects\Tutorial01. As a project file is 

active, the program asks if you want to add the drawing to the project, to which you should answer yes. 

 

Summary of Files 

 Once the job is finished, we list the existing project files in the C:\MDT85 

Projects\Tutorial01 directory. The main files are the following 

 

File  Description 
Tutorial01.prj MDT project file 
Demo1.pun Points file to be imported 
Demo1.dwg Drawing with break lines 
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Exercise 2. Contours and Profiles 
 Each of the lines drawn in their respective layers, being directly attached to topographic points, 

form the so-called break lines. At this point, the "structure" process has been finished, as we have defined 

the planimetry. We will begin the generation of the Digital Terrain Model (DTM). 

 Open drawing Demo2.dwg  in folder C:\MDT85 Projects\Tutorial02 

 

Create Surface 

Select Surfaces > Create Surface (or Surfaces > Creation > Create Surface), or in the project 

window, right-click on Surfaces and Create Surface from the context menu. Select DEMO2.SUP to 

create surface file, in the drawing directory. Activate Points, Break Lines and Boundary Line boxes. As 

for the representation, choose Complete. 

 

To define the list of layers containing break lines, click on Layers button to the right of the 

Break Lines box. To select a previously recorded list of layers press the Load button and select file 

DEMO2.CAP or manually name the layers that appear in the next image with button >. 
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 Press OK and the program begins the triangulation process, by respecting all the correctly defined 

break lines. In the project window, you can check that a surface file is added. 

 

 Once the surface is created, we can obtain all the information associated therewith, for example, 2D 

and 3D surface and perimeter, number of triangles ..., for this we execute the command of Surfaces > 

Information and the following window will pop up: 

 

 Press OK to close the dialog box. 
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Triangulation Editing 

 As an editing example, we will modify the joining of triangles in a given area. Thus, execute 

command Points > Find Point (or Points > Operations > Find), and type 32 and margin 20. 

By observing the joining of points 46 and 32 in the drawing, we see that the terrain would be better 

adapted as 45 and 31. Hence, we enter Surfaces > Insert Line (or Surfaces > Edition > Insert Line) , 

and graphically we join points 45 and 31. 

 

 

Quick Profile 

 Then, we will obtain longitudinal and/or cross section cuts that will immediately indicate the DTM 

layout status. Thus, we zoom in by extension, and use the Quick Profile command in the MDT main 

menu or the Surfaces option. The first point is marked at the center of the image on the West side and the 

second point is also on the center of the East side image (from left to right by the center), and the profile 

with the geometric features and information of the aforementioned elements can be viewed. Change the 

Vertical Factor if desired. 
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Contour Line Generation 

 We complete the DTM process and start with the contour lines, which possibly suggests some new 

edition of the triangulation, in order to have the greatest resemblance to the known terrain morphology. 

We select the option Contours/Cartography > Contours (or Contours > Drawing > Contour) or 

Draw Contours option from the context menu of the project window, by having selected the 

Demo2.sup surface. 

The drawing scale and the comprehensive definition of taken and added points, makes the 

representation with 0.5 m. of normal equidistance. So we modify the Minor box by overwriting this field 

with 0.500. Bear in mind that the validation of the data automatically modifies the equidistance value of 

the master contours to 2.500 (= 0.500 x 5). 

We establish the smoothing factor of the contours at 0, by unchecking the Smoothing factor option, 

as it is advisable not to smooth them initially so as not to overload the drawing.  

 

Press OK to start the process. 

 

 Then, we visualize the modeling effects in detail through their representation of contour lines. 

Extend the surroundings of point 27 with the command Points > Find Point (or Points > Operations > 

Find). 
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We see that the contour-laying under point 27 curls in the direction of point 48 and we avoid the 

contour rate between 30 and 47. We can correct it by inserting a triangulation line between point 31 and 

point 48. Hence, execute the command Surfaces > Insert Line (or the Surfaces > Edition > Insert Line 

option), and join points 31 and 48. Please, observe that both triangulation and contour change instantly. 

 

Contour Line Labels 

 If due to the resulting contour we can have a good estimate, we can finish the drawing with the 

contour line labels, smoothing and status of dimensions. First, we hide the triangulation layer (SRF-

TRIANGULATION), choosing layer 0 as current, or by executing the MDT > Vision command. Then, 

run the command Contours/Cartography > Labeling (or Contours > Drawing > Label). The following 

dialog box is displayed: 
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As the contour is generated every 0.50 mts, it will be convenient to select 2 decimals in the 

Number of decimals box, and in Text Height write 1.5. Press the Automatic button. Zoom in by 

extension. 

 

 We can also draw other labels at the desired points. As an example, select Contours/Cartography 

> Labeling (or Contours > Drawing > Label), press the Manual button and select the last contour level 

to the South of the plot. The program will write the value 45.50 by just clicking on any point in the 

contour. 

In order to project in plane avoiding data massification, we will place a series of significant 

dimensions in singular points. To do this, select the command Contours/Cartography > Place Elevation 

Labels (or Contours > Drawing > Place Heights), set 3 as the Number of decimals, 1.5 in the Text 

Height and Label Angle of label 0. Press OK and you will be prompted for the points in the command 

area. 

 

 
Point: 279.71,238.32 <Enter> 

Height <45.280>: <Enter> 

Text insertion point: <Enter> 

Point: <Enter> 
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 Finally, we can smooth contour lines with Contours/Cartography> Smoothing (or Contours> 

Edition> Smoothing) by specifying Factor 3 and pressing the All button. Once finished, press OK. 

 

Save drawing again on File > Save. 

Draw Alignment 

 Regardless of the abovementioned case for the earthwork measurement, and only for the purpose of 

practicing with the definition of axes and profiles, we design a theoretical alignment with the DTM 

drawing and editing commands. 

Then, we draw the axis from which the profiles are obtained. Therefore, we use the command 

Aligments> Draw Alignment. 

 
Select origin of <Line>/Contour/Input Clothoid: 293.60,346.90 <Enter> 

 

Select azimuth of <Line>/Contour/Input Clothoid: 276.77,287.22 <Enter> 

 

We will see the following window in which we check the Do not show this window box to continue 

entering the data in the CAD command line. 
 

 
 

 

Select end point of <Curve>/Line/Input clothoid/Verify(No)/Delete/Finish: 276.71,276.60  

<Enter> 

 

Select end point of <Line>/Curve/Input clothoid/Verify(No)/Delete/Finish: 286.84,238.94 

<Enter> 

 

Press <Enter> again to end the alignment data entry. 

Once the axis has been designed, the following window will appear in which we will assign the 

Generic Road category and check the Export to file box, to save the alignment in file that we will call 

Demo2.eje.   
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 In order to know the alignments list status, we execute the command Alignments> List Alignment 

(or Alignment> Edition> List), and we select the previous alignment. Press OK in the following dialog 

box and the program shows the alignments list, with definition of Station., X coordinate, Y coordinate, 

their azimuth and radius. 

 

Get Cross-Sections 

 Now, we obtain the cross sections on this alignment. Thus, we execute the option Cross-sections> 

Get Cross-Sections (or Cross-section> Creation> Get Cross-Sections) by selecting the drawing axis. 

In the cross-section profiling dialog box, MDT proposes the DEMO2.SUP file as the surface, which 

is the current surface of the drawing, and proposes as cross section name the same alignment file name 

with TRA format. Finally, we move on to the bandwidth parametrics, entering 40.00 meters on the Left as 

well as on the Right, so that we section the entire model without omitting any areas. Check the Unique 

Points box. The Interval between profiles will be 2.00 meters; though normally excessive, it does not 

generate any problem in its execution. Finally, we check the Draw Cross Sections box, and once the 

profiles are generated, they will be drawn automatically. 
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 Press OK and a message will appear indicating that all the profiles have been generated correctly. 

The profiles will be drawn in plan with their respective cuts and finally a window will pop up before the 

drawing of cross sections. We will validate the drawing window with Space Model, Paper Size in 

Continuous, Horizontal Scale 200 and Vertical Scale 200. We will select the right part of the current 

drawing as the drawing origin. 

 

 

 

 The program also allows us to graphically review these on-screen profiles in a quick one-to-one 

manner, in order to verify them, by indicating the represented STATION and the alignment position 
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coordinate. The latter option is accessed through the Cross-Sections> Review Cross-Sections menu (or 

Cross-Sections > Edition> Review) or its equivalent in the project window. 

We select DEMO2.TRA in the window that shows us the cross section list of the project. Then, the 

program will display the drawing of the cross sections on an alignment and centered. We can move 

forward and backward within the cross sections by pressing the Next and Previous buttons, respectively. 

 

Get Longitudinal Profile 

 Then, we will generate the longitudinal profile of the alignment in the same way that we have 

proceeded with the cross sections. 

For that, we execute the command Profiles> Get Profile. We graphically select the alignment and 

then the following window will pop up where we will establish the generation parameters. We observe 

how the program proposes DEMO2.SUP file as surface, which is the current surface of the drawing, and 

proposes the longitudinal profile to bear the same name of the alignment file, with LON. extension. We 

check the All Cuts and Unique Points boxes and the Draw Profile box, so that as with the cross sections, 

the profile is drawn automatically. 

 

 Once the profile has been generated, the window for the longitudinal profile drawing will 

automatically appear. For the drawing, we will draw it according to the settings that are displayed in the 

following image.  
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 At this point it is important to note that MDT has the ability to draw the profiles according to the 

different representation styles associated with each country. Hence, if we press the Configuration button 

in this window, we will be able to select the drawing style according to the country. 

 

 

 

We validate the window and draw the profile in a free drawing zone. 
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Profile Updating 

 Here, we will update the longitudinal profile drawing automatically from a modification on the axis. 

Thus, we execute the command Alignments> Edit Alignment> Edit Vertex, select the intermediate 

vertex of the alignment and assign a radius of -90.0. 

 

 Then, the program asks if we want to update drawing longitudinal profiles, to which we answer yes, 

and likewise we will do with the update of the cross-sections. 

 

 If we view the terrain values before and after the update, we can check the update that has been 

completed successfully. 
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 Finally, we will label the station and dimension information on certain points of interest on the 

drawn longitudinal profile. Thus, we execute the command Profiles> Drawing> Draw Station and 

Elevation in Profile, the following window will pop up, we validate the window with the default 

parameters. 

 

 Then, we select the drawn longitudinal profile and the points of interest of which we need to obtain 

this information, in the next screenshot you can see how a series of points have been selected above and 

below the profile. 

 

Summary of Files 

 Once the job is finished, we list the existing project files in the C:\MDT85 

Projects\Tutorial02 directory. The main files are the following 

 

File  Description 
Tutorial2.prj MDT project file 
Demo2.cap Layers file 
Demo2.dwg Drawing with break lines and points 
Demo2.sup MDT surface file 
Demo2.eje Alignments file 
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File  Description 
Demo2.tra Cross-sections file 
Demo2.lon Longitudinal profiles file 
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Exercise 3. Volume Calculation 

Get Cross-Sections 

 In this exercise, we are going to show two different methods to calculate the volume between the 

original terrain and the modified terrain: by difference of cross-sections and by grid difference. 

Hence, we will first open the surveyInitial.dwg file that can be found in folder C:\MDT85 

Projects\Tutorial03.  

 

Then, we import the alignment that we will use to generate the profiles. In this case, we will 

import the Alignment1.eje file that we can locate in the cited folder. For this, we execute the 

command Alignments> Import Alignment (or Alignments> Drawing> Import). 

Once the alignment has been imported, we will obtain cross sections thereof with the command 

Cross-Sections> Get Cross-Sections (or Cross-Sections> Creation> Get Cross-Sections) from the 

contour lines. Select the alignment graphically and press the Source button. Choose Layer List and select 

the CV-MAJOR and CV-MINOR layers from the list.  

  

Press OK and specify the parameters shown in the following dialog box. Press the File button 

and name as surveyInitial.TRA and press OK again. 
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Then, we open the surveyFinal.dwg drawing, generating the cross-sections from the 

surveyFinal.sup surface (Digital Terrain Model option in the Source dialog box). For this, we will 

select the same alignment that is already represented and the same parameters of the previous drawing. In 

this case, we will name it surveyFinal.tra.  

 

Volumes by Cross-Sections Differences 

 We can obtain the result of the measurement resulting from the difference between the two pairs of 

profiles, those generated from the surface and those generated from the contour lines with the command 

Quantity take-off> Volumes> Cross-Sections difference (or Volumes> Terrains> Cross-Sections 

difference). A selection window pops up for the first surveyInitial.TRA profile file. After 

validating it, choose the second surveyFinal.tra. Then, the following dialog box appears where the 

cubic measurement report is configured. 0.000 will appear as Station Initial since it is the first cut 

common to both profiles. Set 0.3 as Topsoil Thickness value.  
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The program will calculate the cut and fill volumes, by displaying on screen a list of the surfaces 

and partial and accumulated volumes.  

 

 

Press the Draw button, select Continuous format, Model drawing space, Horizontal Scale 500 

and Vertical Scale 500. In Advanced we establish the cell size, specifying in Horizontal and Vertical, 

divisions of 10 and 5 meters respectively. 

 

 



 

User Manual 29 

Set the parameters for the drawing settings, press OK and select a clear area of the drawing, and 

the profiles will be automatically represented. 

 

 Finally, once the profiles are displayed in the drawing, we have the possibility of deleting them 

automatically. Hence, we execute the command Cross-Sections> Delete Cross-Sections, select the titles 

of the drawn profiles, and observe how they are automatically deleted. 

Volume by Grid Difference 

 Here, we can make a comparison with another volume calculation method. Thus, we open the 

surveyInitial drawing again and then execute the command Grids> Create Grid from Surface (or 

Grids> Creation> Grid from Surface) and select surveyInitial.sup surface file. In the dialog 

box, we set Binary Grid as file type and 0.5 m as cell size. Save information in surveyInitial.MDE 

file. 

 

 We also perform the same operation with the surveyFinal drawing, and therefore the 

surveyFinal.sup surface, generating the surveyFinal.MDE file. 

Then execute the command Quantity take-off> Volumes> Grids Difference (or Volumes> 

Terrains> Grids Difference). Validate the dialog box by pressing OK and select the two previously 

generated files. 

In the next window, the area and volume report appears, with the possibility of drawing a grid with 

the final result. To do this, check Draw volumes and Isolate Layer boxes.  
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 MDT by default will assign a color palette to represent the cut and fill regions, although the user can 

select its own palette from the color palettes proposed by the program. 

 

 

 

Volume by Plots 

 Finally, we can perform the volume calculation of a plot from the two surfaces with which we have 

worked in the previous sections. 

Hence, we open the plots.dwg drawing and observe the distribution of the different plots. Then, 

we execute the command Quantity take-off> Volumes > Volume by Plots. The following window will 

pop up where all the plots will appear by default to perform the calculation, which we validate by 

pressing OK. Then, we select surveyInitial.sup file as the initial surface and 

surveyFinal.sup file as the final surface.  
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Once the dialogue box has been checked, a list will appear with the calculation of the cut and fill 

volume for each plot. When accepted it shows us a dialogue box with the option, as in the previous 

section, of drawing a gird with different shades of color to indicate the cut and fill areas. 
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File Summary 

 Once the work is finished, we list the existing project files in directory C:\MDT85 

Projects\Tutorial03. The main ones are the following: 

 

File Description 
surveyInitial.dwg Original terrain drawing  
surveyFinal.dwg Modified terrain drawing  
Alignment1.eje Alignment of the profiles 
surveyInitial.sup Original terrain surface 
surveyFinal.sup Modified terrain surface 
surveyInitial.tra Cross sections of the original terrain 
surveyFinal.tra Cross sections of the modified terrain 
surveyInitial.mde Grid in original terrain binary format 
surveyFinal.mde Grid in modified terrain binary format 
plots.dwg Drawing with the plots to be calculated 
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Exercise 4. Road Design  

  To perform this exercise, you must have MDT Professional Version.  

In this case, we will start with a survey that has already been triangulated and contoured. Then, we 

will obtain longitudinal profiles and cross sections from an existing alignment and will generate the 

widenings and superelevations. Afterwards, we will define a grade line, associate its type section and 

create the road segment associated with this data.  

  For the correct understanding of these processes, you should have previously executed the 

aforementioned examples of this User Manual. 

Project Selection 

  First, we open the survey.dwg drawing located in directory C:\MDT85 Projects\ 

Tutorial04. Open survey.prj. project as well. 

 

Generate Superelevations 

If you are using AutoCAD 2010 or higher, you can enable the Segments option as you can see in 

the following image, you will have the different orders related to superelevations and widenings. 

 

  To generate the superelevation associated with the alignment, select the option Road/Segments> 

Superelevations> Generate Superelevation from Alignment (or Segments> Superelevatons> 

Alignment). We select the alignment graphically on screen and the following window will appear. We 

select Generic Road Category, and specify as survey.per file. 

 

To visualize it, execute the command Segments> Superelevations> Check Superelevations (or 

Segments> Superelevations> Check) and select the generated file. 
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Get Longitudinal Profile 

  To get longitudinal profiles, we execute the command Profiles> Get Profile (or Profiles> 

Creation> Get Profile). Select the alignmentK press the File button and assign the name survey.LON. 

Check the Unique Points and All Cuts boxes and uncheck the Interval box. We will also check the Draw 

Profile box. Press OK. 

 

  The Simple Longitudinal Profile Drawing command will run automatically. Select Model Space, 

Title survey, paper size DIN-A2, Horizontal Scale 1000 and Vertical Scale 200 and Constant with value 

10. 

 

Press OK and select a point in a free drawing zone. The result will be as follows: 



 

User Manual 35 

 

Get Cross-Sections 

  Likewise, to obtain cross-sections, we enable the Cross-Sections option and run the command 

Cross-Sections> Get Cross-Sections (or Cross-Sections> Creation> Get Cross-Sections). By default, 

cross sections will be saved in the survey.TRA file, in the same folder of the current project. Set as 

Interval 5 and as Distance to Left and Right 25. Check the Unique Points box. Check the Draw Cross 

Sections box.  

 

  Then, the command to draw cross sections will run automatically. Specify as parameters DIN-A1 

format, horizontal and vertical scale 500 and Paper space. When validating the dialog box, the profiles 

will be drawn in the paper space presentations of the current drawing. 
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Grade Line Definition 

  For the grade line definition, we will previously define its vertices, without entering curves, the 

equivalent to the previous grade line. For this, we execute the command Grade Lines> Grade Line 

Input and create a new file called survey.RAS, with Parabolic type curves. 

  Once the new grade line has been selected, we will introduce the station and height of each one of 

the vertices. Hence, we enter the vertices according to the information in the following list. 

 

Once the data corresponding to the previous grade line has been entered, we will define the final 

grade line. Thus, we will enter the parameters of the central curves, by inserting two parabolas entering a 

KV value of 845 for the second vertex and 260 for the third vertex of the grade line. We can enter these 

values by editing the corresponding vertices in the list. 
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Type Section Definition 

  Before obtaining the complete cross sections, we must specify the road sections that will be 

associated with our road. The program initially incorporates a library of platforms, ditches, slopes and 

roadbeds, which can be expanded and customized. 

  On this occasion, we will use these elements, in order to facilitate the learning process.  

Platforms 

  We start by selecting the option Templates> Define - Edit (or Templates> Creation> 

Define/Edit), as a file we indicate survey.scc and the following window will appear, where we have 

a series of platforms available, which we can customize according to our needs. 

 

  Select the Sec-urban2C template, check the option Without Median and press OK. Next, the 

alignment will be requested, which can be specified either by selecting it graphically or by means of a 

file.  

  Then, a general window will be displayed for the definition of the element types that make up our 

section. We will make a definition of the platforms along the alignment according to the image that 

appears below. 

  The idea is to define a road, in which there is no sidewalk in the first 200 meters and then a 

sidewalk appears with its curb up to the final station of the alignment. 

 

For that, we will take the following steps: 

  Press the Insert button , a window will appear with the final station of the alignment. We 

validate it and the assignment will be automatically created in the indicated station. 

  We will also perform the insertion for station 200, by pressing the same previous button. 

 In the assignment of station 200, we set the dimensions of the Footpath and Curb vectors on both 

sides of the alignment to 0. The result would be the following screenshot: 
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  Given that MDT interpolates by default between the stations of different platform assignments, in 

this situation, station 200 will directly enter the sidewalk already defined in the final station. For this, we 

select the final station and press the Duplicate button  We establish station 200 as the new station.  

 

 Once we have the assignment in the indicated stations, we can modify the values of each vector in 

each of the stations, as it appears in the following image. 

  Now it is necessary to change the superelevation behavior for certain elements. Hence, if we 

position the button on the header of any vector and press the right button, we have the Activate / Disable 

Superelevation option. Leave superelevations only as Lane1, Lane2 and Outer hard Shoulder. The 

superelevation vectors appear in pink color, as shown in the figure. 
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  Once the platform is defined, we see that we only need one lane on each side instead of the two that 

appear. Likewise, in order to eliminate the lanes, in the case of superelevations, we position the vector on 

Lane2 column and run the Delete option, after confirming it. We do it on both sides of the alignment, 

leaving the assignment as it appears in the following image. 

 

Roadbeds 

  To define the roadbed, click on the corresponding tab, and also in case of platforms, press the Insert 

button, inserting an assignment automatically in the last station. 

  In the assignment that appears, we will change the roadbed thickness to value 1. Then, we will 

change the Criterion to Slope and the Slope/Cond. value to 4,000. The final result will be the one that 

appears in the next window. 
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Ditches 

  To define the ditch, click on the Ditches tab and press the Insert button. Then, you will see a set of 

ditches already defined, to which you can add new ditches or modify existing ones. 

  In this case, we are going to use ditch no. 1, but we are going to add one more vector. Press the 

Insert Next button and assign the new vector with values 0.5 in X and 0.25 in Y. 

 

  Once the window is validated, the station to which we are going to make the assignment will be 

requested. Thus, we check the Assignment by Interval box and we set 100 as Initial and 200 as Final. It 

will be possible to observe, if we move to one of the stations where there is a ditch, how it is already 

drawn according to the indicated features. 
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Cut Slopes 

  To define the cut slopes, click on the Cut tab and press the Insert button. Then the following 

window will appear, where the slope to insert must be selected, and in this case we will select the first of 

them, which has a fixed slope of 1.5. 

 

Once the window has been validated, we will indicate that the assignment will be made to Final 

Station, and the assignment of the applicable slope will appear as in the following image: 
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Fill Slopes 

We will proceed in the same way as we have assigned the cut slope. In this case, the value of the fill 

slope will be 0.667. 

 

 

  If we click on the Top View tab, we visualize in design time, how the road defined in the plan would 

look like. In this case, we have placed ourselves in station 200. Thus, we will represent it by taking station 

200 of the alignment as a central reference, which can be visualized with a yellow line. 



 

User Manual 43 

 

  Press OK to leave the section definition command. 

Widenings Definition 

  Finally we will define the widenings associated with the road we are defining. Hence, we run the 

command Segments> Widenings> Generate Widenings. The command will request the alignment and 

automatically generate a file of widenings according to the selected Category. In this case, we will select 

the regulations that appear in the following image, we will assign the name proposed by the program by 

default, survey.SOB. 

 

  We can visualize the width information. Thus, we run the command Roads/Segments > Widenings 

> Widenings Report and select the previously generated file. 

 

  Once we have defined our full type section and the rest of the elements that make up the road 

(alignments, profiles, grade lines ...) we can group them so that from this moment we work with a single 

file that brings them together. 

  Hence, we choose the option Road/Segments > Define – Edit (or Segments > Creation> 

Define/Edit) and specify the name of the new file a survey.SEG. Then, we press the Automatic button, 

all the linked files will be automatically imported. 
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Draw Longitudinal Profile 

  Now we can represent both the longitudinal profile and the cross sections completely. To do this in 

the MDT menu, select the option Road/Segments> Draw Longitudinal Profile (or Segments > 

Drawing> Draw Longitudinal Profile) and select the survey.seg file. Set 1000 and 200 as scale 

values for Horizontal and Vertical respectively, and specify value 10 as Constant interval. In Paper size, 

set Continuous. Press OK and specify an insertion point for the drawing. 

 

 

Automatic profile update 

  Then, after drawing the profile we have detected that the curve value of the second grade line vertex 

is not correct. Thus, we run the command Grade Lines> Vertical Transition Curve and we select the 

first grade line vertex. We assign value 890 to KV and press the "enter" key so that the other values are 

recalculated.  
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  When the dialog box is validated and confirmed, we observe how the drawing of the grade line is 

updated automatically with the agreements, then a message will be displayed, asking if you want to 

update the associated segment, you should answer yes. 

 

Draw Cross Sections 

  Conversely, to draw the cross sections, choose the command Segments > Draw Cross Sections (or 

Segments> Drawing> Draw Cross - Sections), and select the survey.SEG file. Specify DIN-A0 

format, horizontal and vertical scales 500, Survey title and also select the Paper Space option. Press OK 

and then draw as many sheets as necessary to draw all the cross sections. 
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 Save drawing again as survey.DWG, in directory C:\MDT85 Projects\Tutorial04. 

 

 

Summary of Files 

 Once the job is finished, we list the existing project files in the C:\MDT85 

Projects\Tutorial04 directory. The main files are the following 

 

File  Description 
survey.dwg Drawing with the terrain 
survey.prj MDT project file 
survey.per Superelevations file 
survey.lon Longitudinal profiles file 
survey.tra Cross-sections file 
survey.RAS Grade lines file 
survey.scc Sections file 
survey.seg Segment file 
survey.sob Widenings file 
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Exercise 5. Definition of Reinforcements  

   To perform this exercise, you must have MDT Professional Version.  

  In this unit, we start from a topographic file in which a road already exists. The objective of this 

exercise is to define a more uniform road, with a new layout, so that you can make use of the existing 

road in those areas where both roads are coincident and the height difference allows so. 

 Hence, first we open reinforcements.dwg drawing located in directory C:\MDT85 

Projects\Tutorial05.  

  Then, we import the alignment of the new road. For this, we run the command Alignments> 

Import Alignment and select the Alignment.EJE file.  

 

  Next, we generate the cross sections of the natural terrain. For that, we run the command Cross-

Sections> Get Cross Sections, graphically selecting the alignment and generating them every 5 meters, 

with enough width to the left and right so that the section can be developed, in this case, as Left and Right 

width on both sides we will establish 15 meters. We will name the cross section file 

reinforcements.TRA. It is not necessary to draw them in the meantime. 
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Segment Definition 

  Once the cross sections have been generated, we will build the segment. So, in this exercise the 

other road elements have been previously defined, that is, the longitudinal profile, the grade line and the 

type section. We run the command Road/Segments> Define/Edit, the new segment will be called 

reinforcements.SEG and we will import the different components from the project folder 

successively: Alignment.EJE, reinforcements.LON, reinforcements.TRA, 

reinforcements.RAS and reinforcements.SCC. 

 

  In the segment preview, you can see the delimitation of the road from which we are going to make 

the use of the roadbed. 

Reinforcement Definition 

  Once the segment has been defined, we are going to modify the road type section so that it 

considers the existing road surface, aimed at making use of the roadbed. 

  To do this, run the command Templates> Define/Edit, select reinforcements.SEG segment 

and click on Reinforcement– Others tab. 

 

  Then we check the Apply box, and establish -0.8 and 0.8 meters as tolerance values for Minimum 

Dif. and Maximum Dif. respectively. The value corresponding to the roadbed thickness. As the objective 

is the full use of the existing roadbed, check the Adjust to terrain box. 
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  Finally, it is necessary to indicate the new road where the existing road is located. For this, we press 

the Designate Polylines button and select the two blue polylines that define the boundary of the platform. 

 

  Automatically, if we move forward in the different existing stations, we will observe how, in certain 

stations, there are two red marks, indicating the point where the road takes place and how the type section 

will adapt to the existing road. 
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  Then, we can draw the segment from the Cross-Sections> Draw Cross-Sections option by 

selecting the reinforcements.SEG file. In the drawing, we can clearly see the use of roadbed that is 

made in certain stations. In this case, we are going to draw with Paper Size in Continuous, Horizontal 

and Vertical Scale at 500. 

 

  Finally, we can obtain a list of volumes where the reinforcement area and volume is reflected. To do 

this, we run the command Quantity take-off > Surfaces > Roadbed Measurement Reports, select the 

reinforcements.SEG segment and validate the window with the default data that appear on the 

initial station and final station.  

  After carrying out the calculation process, the following list will appear, in which different concepts 

are reflected, among them, the reinforcement areas and volumes. 
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Summary of Files 

 Once the job is finished, we list the existing project files in the C:\MDT85 

Projects\Tutorial05 directory. The main files are the following 

 

File  Description 
reinforcements.dwg Drawing with the terrain 
Alignment.eje Alignments file 
Alignment.tra Cross-sections file 
reinforcements.seg Segment file 
reinforcements.lon Longitudinal profiles file 
reinforcements.ras Grade lines file 
reinforcements.scc Sections file 
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Exercise 6. Drawing Sections 

  To perform this exercise, you must have MDT Professional Version.  

 In this unit we start from a topographic file in which we have sent the drawing plan of the break 

lines that define the road. The objective of this example is, first, to assign properties to those polylines 

that have a double meaning, and second to read the drawing and build the section automatically. Once the 

section file has been generated, we will create the segment or road with the other project files. In addition, 

through the different available commands of the program, we will see the final state of the new type 

section. 

 For correct understanding these processes, you should have previously executed examples 1, 2, 3 

and 4 of this User Manual. 

Start by opening survey.dwg drawing located in directory C:\MDT85 

Projects\Tutorial06. 

 

 Initially we will assign the appropriate properties to those polylines that are necessary. In our case, 

we have two polylines drawn in the CURB layer that correspond to two vectors in our section, 

corresponding to the low and high points of the curb, as shown in the figure. 
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 We will assign two different behaviors to these polylines: the line corresponding to the foot of the 

curb, which will not have any variation with respect to the polyline that precedes it, and the one 

corresponding to the height of the curb, which has a difference of 20 centimeters regarding the bottom of 

the curb. 

 To carry out this definition, we run the command Templates> Assign properties to vector 

platform (or Templates> Creation> Vectors properties) and select the two polylines that are in the 

CURB layer, in red color. Then the following window will appear with the same properties that will 

appear empty initially, since no property has been assigned yet: 

 

 Then, we move on to assign the properties as we have commented previously. For the low curb we 

do not apply any variation and for the high curb we apply a difference of 20 cm leaving the definition as it 

appears in the following image: 

 

 We can check how a new layer is created in which the named polylines will be drawn once we 

validate this window. This layer name is the one that will serve as reference for the automatic creation of 

the curb. 

 

 After assigning properties to the different polylines, we automatically create the sections based on 

the existing information in the drawing. 
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Hence, we execute the command Templates> Convert platforms from drawing, (or Templates> 

Creation> Drawing convert) we select a new file, in this case, we will call it road.SCC. We also select 

the project alignment, which can be named on the screen or as a file, and the following window will pop 

up: 

 

 We modify the parameters as shown in the previous image and in Layers we select the layers in 

which the polylines are located, that we want to consider for the section generation, as can be seen in the 

following image. 

 

 Then, press the Options button and enter 0.005 as tolerance for both horizontal and vertical values. 

 

 Finally, we validate the windows and select all the visible entities of the drawing, and begin the 

process of generating sections from the drawing. Once completed, the section file with the information of 

the corresponding platforms will be created automatically. Then, we can run the command Templates> 

Define/Edit (or Templates> Creation> Define / Edit) and visualize the created sections file, where we 

can already view the curb definition. 
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 In this window, as was done in example 4, we assign slope 1 both for cut and fill to the final station 

with the default values to complete the definition of our type section. The section will appear as shown in 

the following image. 

 

 Finally, we will create the road segment. For this, we run the command Road/Segments> 

Define/Edit (or Segment> Creation> Define/Edit), create a new road.seg file and successively 

import the files that we find in the project folder, so that the final result should be the following: 

 

 Once the segment has been created, and with the different revision or vision commands that are 

available in the program, we can see the final state of our road. For example, execute Maps/Render > 

Route by Road (or Maps/Render > Viewer > Route by Road). 
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Summary of Files 

 Once the job is finished, we list the existing project files in the C:\MDT85 

Projects\Tutorial06 directory. The main files are the following 

 

File  Description 
survey.dwg Drawing with the terrain 
survey.scc Sections file 
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Exercise 7. Definition and Calculation of Roadbed Layers 

  To perform this exercise, you must have MDT Professional Version.  

 The objective of this exercise is to define the roadbed surface and the roadbed layers associated with 

a road, as well as the calculation of the volumes of each of the roadbed layers. 

 To begin, we will define the section from a polyline in elevation which represents the final state of 

our section. First, we open layers.DWG drawing inside folder C:\MDT85 

Projects\Tutorial07. 

Define from Polyline in Elevation View  

 We execute the command Templates> Define from polyline in elevation view. We select the new 

file LAYERS.SCC, then, we select LAYERS.EJE file as alignment and finally the polyline of the 

drawing, which is going to be our type section. 

Then the following window will appear, where we will indicate the starting point of each one of the 

section elements by pressing the corresponding buttons to each section element. As an aid, we can use the 

reference methods to CAD objects (end point, midpoint, etc.). 

 

Platform: We will indicate as alignment position, the intersection of the vertical line with the platform.  

 

 

Left Ditch: We indicate as the point of attachment, the end of the platform. It will be applied only in Cut. 

 

Right Ditch: We uncheck this option, since there will be no ditch on the right side. 

Left Slope: As with the left ditch, we indicate the point of attachment at the end of the ditch. This would 

be a cut slope. 
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Right Slope: We indicate the point of attachment at the end of the platform on the right side. This would 

only apply to fill slope. 

 

 The final data window status after selecting all the elements would be as follows:  

 

 Select Fill option for Right slope. Then we validate the dialog box by pressing OK and the 

definition of the type sections will automatically appear according to the definition we have just made. 

The program has automatically assigned the names L1 and R1 to the platform vectors. Therefore, 

before defining the roadbed, we change their name to Lane1. This can be done by selecting the name of 

the vector with the right mouse button and running the Change Vector type option. The final result would 

be the following: 
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Definition of Roadbed Layers 

 Then, we define the roadbed and the roadbed layers associated with it. For this, we click on the 

Roadbeds tab and define a roadbed with 1 meter of  Thickness with Criterion Parallel. 

 Next, we press the Roadbeds Layers button  and the Roadbed Catalogue will appear. Select 

catalogue T00-E3-0033 and press OK until you exit the section definition command. 

 

 

 

Segment Definition and Layer measurement  

 Once the type section is defined, we will build the segment. For this, we run the command 

Roads/Segments> Define/Edit, call the new segment layers.SEG and import its different 

components. These components can be found in the project folder in the sections file that we have just 

defined. 

 

 Once we have already built our road or segment, we can draw it. Hence, we run the command 

Cross-Sections> Draw Cross-Sections and select the segment that we have just created. In the window 

that pops up, press the Advanced button and check the Draw Roadbed layers box. 
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 Finally, we are going to calculate the cubic measurement of the roadbed layers. For this, we run the 

command Quantity take-off> Volumes> Roadbed Layer Measurement Report, and validate with the 

options proposed by the default program. 

 

 

Summary of Files 

 Once the job is finished, we list the existing project files in the C:\MDT85 

Projects\Tutorial07 directory. The main files are the following 

 

File  Description 
layers.DWG Drawing with the section 
layers.SCC Sections file 
layers.EJE Alignments file 
layers.SEG Segment file 
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Exercise 8. Get Modified Terrain 

  To perform this exercise, you must have MDT Professional Version.  

 Open the survey.dwg drawing inside folder C:\MDT85 Projects\Tutorial08.  

 Run the command Surfaces> Get Modified Terrain (or Surfaces > Earthworks> Modified 

Terrain), type F and select SURVEY.SEG file. In the dialog box, check the option Modified Surf., so 

that it will save the new surface in the survey2.SUP file, leaving the original surface intact. Leave the 

other boxes as they appear in the figure. 

 

Finally press OK and after finishing the calculation process, the result would be the following: 

 

The original terrain is automatically modified by inserting the defined road and modifying the 

surface. If we use the Quick Profile option, we can visualize the modifications made to the model. 
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Area and Volume Report 

 A cubic measurement list of the defined road will be obtained next. To do this, run the command 

Quantity take-off> Volumes> Area and Volume Report (or Volumes> Sections> Cubic 

Measurement), select the segment file and press OK. 

 

 Then, a report will be displayed with the calculation of the area of each cross-section with their 

corresponding volumes.  
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Measurements Report 

 Then, we will obtain some surface and volume lists that will be useful for the calculation of 

earthworks. 

Run the command Quantity take-off> Surfaces> Cross-Section Measurement Report (or 

Volumes > Sections> Surfaces> List of Cross-Section Measurement) and select the SURVEY.SEG 

file. The calculation that we want to make relates to areas measured in plan. Hence, we select Surface and 

On ground plan options for the calculation type. We validate the dialog box.  

 

 Then, if our road has a defined roadbed, a window will appear where we must select the roadbed 

layer on which we want to carry out the measurement. In this case, only the grade line and subgrade will 

be displayed, because we have not defined any intermediate roadbed layer. We will select Grade line. 

 

After that, a section by section report of the crown and slope areas of the road will be displayed. 
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 Then, we obtain a list of the roadbed measurements, that is, band length, hard shoulder, road, etc. 

To do this, run the command Quantity take-off > Surfaces > Roadbed Measurements Report (or 

Volumes > Sections > Roadbed > Roadbed Measurement List). Select the SURVEY.SEG file and 

validate the dialog box. 

 

 In this list, the volume of roadbed and reinforcement data are null because we have not defined 

them in our type section. 

Setting out Lines 

 We will set out lines of the road. To do this, run the command Setting Out> Setting out Lines (or 

Setting Out> Segment> Setting out Lines), select the survey.SEG file, select Grade line as the layer 

to be analyzed, and in the dialog box, check the list of elements to represent the Crown and Foot of Slope 

line. Set value 10 as Interval in Straight line and Curve and press OK. 
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 Next, a list will be displayed showing the coordinates and other characteristics of each set out line. 

 

  Then, we will perform a height analysis of the section. Thus, we run the command Setting 

Out> List of heights (or Setting Out> Segment> Height List). We will select the survey.seg file 

and then indicate that we are going to work on the Grade line as in the previous cases. The following 

window will pop up where we will indicate the vectors from which we want to analyze the heights and 

configure the data to be analyzed according to the following image, by clicking the icon > to select the 

vertices to be listed. 
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 Once the data to set out lines has been established and the window has been validated, the following 

setting out list will appear.  

 

 It is also possible to generate a list showing the height of each of the platform vertices as well as the 

difference in elevation with the terrain and the slope of each platform vector. Hence, we run the command 

Setting Out > List of platform vertices. 
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Route by Road 

 Run the command Maps/Render > Route by Road (or Maps > Viewer > Route by Road), press 

the Segment button and select the EJE1.EJE file. Then press the Surface button and select the 

survey2.SUP file. 

We configure the simulation parameters according to the attached window. 

 

 

 Also fill the Observer Height box with value 4. Press OK and a window with the realistic 

representation of the road will be displayed.  

 

 
 



68 MDT Version  8.5 
 

Summary of Files 

 Once the job is finished, we list the existing project files in the C:\MDT85 

Projects\Tutorial08 directory. The main files are the following 

 

File  Description 
survey.dwg Drawing with the terrain 
survey.SEG Segment file 
survey2.SUP Surface file 
Eje1.EJE Alignments file 
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Exercise 9. Create Platforms  

To perform this exercise, you must have MDT Professional Version.  

 In this case, we describe how to perform earthworks or excavations from a previously defined 

digital model. On the resulting and original model, we will perform a calculation of volumes by grids, 3D 

and rendering representation by assigning materials. 

Draw Platform 

 Open Terrain.DWG drawing, inside directory C:\MDT85 Projects\Tutorial09. The 

Tutorial9 project will also be opened automatically. 

On the drawing, we will insert a block with the platform to be made. To do this, run the CAD 

command Insert> Block, press the Browser button and select Platform1.dwg drawing in the same 

folder. Insert it in coordinates 0.0, with scale 1, angle of rotation 0, and with the option Explode, or else 

explode the block once inserted. 

 

Earthworks by Platform Height 

 First, we will run the command so that the earthwork is as balanced as possible, that is, the cut and 

fill volume is similar. 

Hence, run the command Surfaces> Earthworks> by Platform Height (or Subgrade Height icon 

in the Earthworks panel of the Surfaces option) and select the polyline of the inserted drawing. Then, 

the following dialog box is displayed where the earthwork features are configured. 
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 In the Subgrade box, enter the 580 height, and check the Target Volume box. Then after pressing 

the Details button, the following window will pop up, which we will configure in the same way as it 

appears in the following image: 

 

 

 Press OK and the program will propose a set of possible solutions. We will select the third option, 

the one in which the difference is minimal. 

 

We validate the window and the program will automatically create a new surface named Terrain2, 

which will be drawn with its contacts. 
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 To view the model changes, use the Quick Profile command from North to South of the platform. 

Observe how the action performed is clearly distinguished. 

 

Earthwork by Terrain Height 

 Using the current surface as a base, we will perform a earthwork in which we know the terrain 

contacts instead of the contour of the platform.  

Set 0 as the active layer and insert the Platform2.dwg block in the same way as explained in the 

previous section. 

Run the command Surfaces > Earthworks > by Terrain Height (or Surfaces > Eartworks > 

Subgrade height) and select the new polyline. The following dialog box will appear, where the platform 

properties to be calculated will be specified. 
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 On platform height, enter 575 and for the other boxes keep the default values specified by the 

program. Validate the dialog box. 

 

 Likewise, if we execute the Quick Profile command, we can visualize the current status of our 

model. 
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Earthwork along Subgrade Height  

 Then, we will execute the earthwork again in which the slopes will be different depending on the 

side of the polyline that defines the platform. Hence, first insert the Platform3.dwg block. 

Run the command Surfaces> Earthworks> By Platform Height and select the polyline that we 

just inserted. We set the platform height at 557 and then press the buttons indicated in the following 

image. 

 

 

When selecting these buttons, the following window will be displayed in which we can establish the 

slope values according to the side of the polyline. 

In the case of Cut Slope, we will establish value 0.667 for the North and South polyline sides and 

we will establish 1.5 for those located East and West. 

In the case of Fill Slope, we will establish value 0.5 for the North and South polyline sides and we 

will establish 1.0 for those located East and West. 

 

Cut Slope 

 

Fill Slope 

 

The final result would be: 
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Fill Height 

 Finally, on the earthworks that we have executed in the far north of the terrain, we will simulate a 

fill at a certain height. 

Thus, run the command Surfaces> Earthworks> by Height Fill, name a point in the center of the 

platform located to the north of the drawing, and validate the dialog box with a height of 575, keeping the 

other parameters with their default values. 

 

 

 

 

The following result will appear: 
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Route by Terrain 

 Then, we will take a virtual tour of the terrain. To do this, run the command Maps/Render> Route 

by Terrain (or Maps> Viewer> Route by Terrain), select the Terrain5.SUP surface and specify 50 

as Observer Height.  

 

 Press OK and the terrain viewer will start. Experiment with the controls to change the image. 

 

Summary of Files 

 Once the job is finished, we list the existing project files in the C:\MDT85 

Projects\Tutorial09 directory. The main files are the following 

 

File  Description 
Terrain.DWG Drawing with the terrain 
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File  Description 
Tutorial9.prj MDT project file 
Esplanade1.dwg Drawing with subgrade block 
Esplanade2.dwg Drawing with subgrade block 
Esplanade3.dwg Drawing with subgrade block 
Terrain5.SUP Surface file 
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Exercise 10. Alignments 

  To perform this exercise, you must have MDT Professional Version.  

 In this example, we will describe the fundamental tools of the alignment calculation command. 

First, open the Alignments.dwg file in directory C:\MDT85 Projects\Tutorial10. In 

the drawing, there are two white lines, which represent an existing path, and some lines and arcs that we 

have identified, that we will use to build an axis that passes nearly through the center of existing path, 

from left to right. 

 

 Run Elements > Calculate and select arc A1 located to the left of the drawing. A window will 

appear in which you can see the alignments that we will use to design the alignment.   

 

  Press the Insert after button and press the button < to name and select line A2, located inside the 

path. 
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The program automatically calculates the transition clothoid between the line and the contour, and 

assigns parameter A2 (the output clothoid) to element number one. 

 
Then, we select the second element, clicking on any column. An arrow appears to the left of the 

row confirming the selection. By pressing the Insert after button, in the list select Rotating and press OK. 

In the list, element 3 appears in red, indicating that it has not been calculated yet.  

 

 
 

By clicking on its corresponding box X(P1) of the third row and the button ..., we select the point 

P1 using node CAD object snap reference, and enter a radius of 45 and a parameter A1 of 30. 

 
 

Now we select again the third element in the list, press Insert after, and we select the next line A3. 

We repeat the process with element 4, selecting the next line A4. The program automatically calculates 

the clothoids that enable the alignment continuity. 
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After element 5, with Insert after, we select from the Floating list and press OK. In order to 

calculate the floating element, there must be elements calculated before and after. Pressing again Insert 

after we select the next arc A5. We can see that in the drawing, we have calculated a floating line, which 

is not of interest. We have a better solution changing the mobile radius to 400. 

 

 
 

 Thus, the axis is calculated, and pressing OK in the alignment calculation screen, a window appears 

where you can assign a name and an initial station.  
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Summary of Files 

 Once the job is finished, we list the existing project files in the C:\MDT85 

Projects\Tutorial10 directory. The main files are the following 

 

File  Description 
Alignments.dwg Drawing with alignment 
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Exercise 11. Road Intersections 

  To perform this exercise, you must have MDT Professional Version.  

In this exercise, we will describe the tools necessary to automatically build an intersection between 

roads. All the necessary files to make this module can be found in folder C:\MDT85 

Projects\Tutorial11. 

For the intersection process, MDT will consider two types of roads: the MainRoad, a roadway that 

is developed in its entirety according to its definition and the SecondaryRoad, which must be adapted for 

the intersection with the main road. 

In addition, it is convenient to check the option Draw Surface in 3D within the option Utilities> 

Configuration> Surfaces, so that when performing 3D views with CAD you can see clearly its 

development. 

 

Grade line adapted to intersection  

Before running the intersection command it will be necessary to adapt the grade line of one of the 

links that we are going to execute, to the road with which it will intersect. Therefore, we run the 

command Profiles> Draw Simple Profile and select SecondaryRoad.LON file, with Continuous 

Paper Size, Horizontal and Vertical Scale 1000 in Model Space. 
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 Then, we will define the previous grade line with a polyline so that it adapts to the longitudinal one 

in the region coincident with the main road, in this case between the two red circles that can be viewed in 

the previous image. 

Thus, the usual would be to define a polyline similar to the one shown in the following image and 

then execute the command Grade Lines > Convert Grade Line from Polyline. 

 

 To facilitate the performance of the exercise, this grade line must have been defined. Therefore, if 

we proceed to import it we can see how it adapts to the longitudinal at the intersection with the main road. 

Therefore, execute Grade Line > Import Grade Line, select the polyline of the terrain on the profile and 

select SecondaryGradeLine.RAS file. 

 



 

User Manual 83 

 Once the grade line is defined, we enter it in the segment. To do this, we run the command 

Roads/Segments> Define/Edit and select SecondaryLinkRoad.SEG file and import the grade line 

file that we have just defined by selecting the row with the GRADE LINE element and pressing the 

Import button. 

 

 

Horn-Type Intersection 

 In this first intersection, we will draw a horn-type intersection. Hence, we open survey.DWG 

drawing in folder C:\MDT85 Projects\Tutorial11. We will perform the road intersection that 

appears marked in the following image. 

 

 Then, we run the command Surfaces> Get Modified Terrain, select 

SecondaryLinkRoad.SEG file and run the command according to the configuration that appears in 

the attached screenshot. Set value 23 as Initial Station and 90 as Final Station. 
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 After running the command, the drawing will remain according to the attached image, only in the 

absence of executing the intersection between both roads. 

 

 To perform the intersection, run the command Segments> Road Intersection, the following 

window will be displayed: 

 

We select the Roadbed option and the horn-type intersection, corresponding to the image on the 

left. After selecting the intersection type, it will request the SecondaryLinkRoad.SEG link road and 

the MainRoad.SEG main road. 

Then the command will ask us to name the intersection point, and select any point within the region 

where the intersection will take place, for example 638418.73,9338442.68. Once the point is named, the 

following window will appear where we will establish all the necessary parameters for the execution of 

the intersection. For this intersection, we establish the same values that appear according to the following 

image. Set the Intersection Zone as in the following image. 
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 Press the Calculate Intersection button and automatically observe how the intersection is built. 

Once finished, the program will offer us the possibility of undoing the operation to execute it again with 

other parameters or finish. In this case, we choose to end the process and press the "Enter" key. 

In the next two images we can observe the intersection from two viewpoints. 

  

Then you can see the same intersection with a contour with equidistance of 1 meter between contour 

lines. 

 

Link Intersection 

 For the execution of this intersection type, we will use the segment or road whose grade line we 

have defined at the beginning of the exercise. 

We first execute the command Surfaces> Get Modified Terrain and select 

SecondaryRoad.SEG file. We set station 21 as final station. The other parameters  remain as they 

appear in the following image. 
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 The final result would be that of the next screenshot, where we can observe the main road, the 

secondary road and the intersection pending execution. 

 

As in the previous intersection, we execute the command Segments> Road Intersection, choose 

the link type (image on the right), select SecondaryLinkRoad.SEG secondary road, and then 

indicate that we are going to calculate the intersection in relation to another segment. For this, in 
the command line select the option "S" of "Segment" and select MainRoad.SEG file, then 

Intersection Start Point will appear, select a point near the blue mark that we can see in the previous 

image. 

Once the point is selected, the following window will be displayed where we will select Roadbed 

and the link type intersection. 
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 Once the intersection of link type has been selected, the window where we will configure the 

different parameters for the execution of the intersection will be displayed. For this example, we will 

validate with the parameters that appear in the following image. We can also check the Calculate 

Volumes option so that once the intersection is executed, it shows us the calculation of the volume that 

concerns the executed intersection. 

 

 As in the case of the horn-type intersection, the command will allow us to undo the intersection in 

order to execute it with other parameters, or on the contrary validate it and consider it as correct. 

 

  

 

 Finally we can contour with the interval proposed by the default command and apply a 3D View to 

the drawing. 
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Summary of Files 

 Once the job is finished, we list the existing project files in the C:\MDT85 

Projects\Tutorial11 directory. The main files are the following 

 

File  Description 
SecondaryGradeLine.RAS File with grade line 
survey.dwg Drawing with cartography 
SecondaryRoad.SEG Segment file 
MainRoad.SEG Segment file 
SecondaryLinkRoad.SEG Segment file 
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Exercise 12. Survey Calculations 

The aim of this example is to convert a file produced in the field, calculate the point and station 

coordinates, compensate a traverse and transform the coordinates. 

First, edit the configuration using the Utilities > Configuration command, press Surveying and in 

the Mode field choose Beginner. Accept the changes. 

 

Data Collector File Conversion 

 The first step is to convert the file from the total station or the data collector used for the survey. For 

that purpose choose Surveying > Import. Select as the manufacturer TCP, specify the format as 

Levantamiento ASCII and choose the network.LEA, file in the C:\MDT85 

Projects\Tutorial12 folder.  Activate the three boxes in the After Converting frame. 

 

 

 Accept the proposed file name for destination. The following dialog box allows the revision of the 

imported observations, deleting the erroneous ones, deciding upon whether to interpret them as point 

observations or station observations (in the case of incorrect interpretation) and to process repeated 

observations. In this example we press OK without making any changes. 
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Coordinate Calculation 

 We can now proceed to calculate the station and point coordinates. The list in the top left-hand side 

of the screen (Origin Station) corresponds to the stations where we positioned ourselves in the field. 

Scanning this list shows how the program informs us of the stations visited since the selected ones 

(Target Stations), the instrument heights and the point read from it (Instrument Setups). For example, 

from station 1, stations 2, 5 and 6 were measured in Double mode, i.e., there and back, and 3 and 4 were 

measured in Simple mode, i.e., one way only. Select other stations to see how the information changes. 

 

 

 

 We can edit or view the station and point observations easily. Use the Observations button in the 

Stations frame and a complete observations list is shown. Double clicking on any of them or pressing the 

Edit button allows viewing or modification to any field. For point observations, use the Observations 

button in the Points frame. 
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 The next step is to assign some coordinates, starting from the origin station (in this case number 1). 

Select this station and press Assign. Type x=300000, Y=4000000, Z=100 and validate, observing that 

Fixed check box in the Station Calculation dialog box is now active and that the coordinates also appear 

in the Calculated Coordinates frame.  

 

 

 

 Now we proceed to automatically calculate all the stations and points, following the sequence of the 

original field file. First we tell the program, which is the station of origin, selecting 1 and we activate the 

Origin box. Observe that the Automatic button is highlighted.  

 

 

Press the Automatic button to show a results report in which are shown the calculated stations, 

the method used and any errors in distance, height or angle. Asterisks indicate that the pre-set limits have 

been exceeded. Pressing OK assigns all of the coordinates to their corresponding stations and points. 
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 We can check that all the stations have been oriented. Press the Instrument Setups button and a 

dialog box appears showing the apparatus heights and the horizontal corrections for each one. Click OK. 

 

 

 

 Selecting other stations, the calculated coordinates appear as before. Choose station 8 in Origin 

Station list. We can see that the calculated coordinates appear from 2, 5, 10 and 11. Further on we will 

see other methods to help us better understand this concept. If we wish to check the station coordinates, 

we press the Coordinates button in the Stations frame.  

 

 

 

The points also have assigned coordinates. To view them press the Coordinates button in the 

Points frame. 
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Station and Point Drawing 

 Now we can draw the stations and the points. For stations, in the Station Calculation dialog box, 

press the Draw button, then Stations and then Station Observations. Lastly, press OK twice and perform 

a zoom extension.  

 

 

 

We can see the drawing structure. A triangle, and the mobile stations by a circle represent the 

fixed stations. A yellow line represents double observations and simple observations are shown in red. 
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In order to draw the points, we enter again into Station Calculation , but this time choose the 

Surveying  > Drawing > Draw Points command, with the All option on and press OK.  

 

The next dialog box controls the drawing parameters. We use a scale of 1:500  and leave the rest 

of the values unaltered. Click OK. 

 

 

 

 

Other Calculation Procedures 

 The Surveying module also allows the survey calculation to be performed with more control. We 

will manually calculate two stations. Select station 1 in Origin Station list and station 2 in the Stations 
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list. Press the Manual button. The program show the information from the observations of  1 to 2 and 

from 2 to 1, as well as the distances and slopes both coming and going, with their associated 

disorientation. 

 

 Now choose the Surveying > Utilities > Reverse Intersection command. Select instrument setup 

according to station 8 and press OK. 

 

 Choose the Angles and Distances method and in Options highlight 3D. Observe the representation 

of angles with respect to the desired station, error ellipse and station 8 station coordinates. Press OK.  

 

 Using again the Station Calculation command and selecting 8 as the station of origin, we can see 

how the new solution for the existing coordinates is presented. 

Summary of Files 

 Once the job is finished, we list the existing project files in the C:\MDT85 

Projects\Tutorial12 directory. The main files are the following: 

 

File  Description 
network.LEA Original survey data  
network.LEV Survey data in MDT format 
network.DWG CAD drawing 
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Exercise 13. Traverses 
 In tutorial 12, Topographical Calculations, the steps have been taken to calculate some provisional 

coordinates for the surveying stations. These coordinates are now going to be offset by calculating a 

polygonal. In this case, the most suitable aspect would be to use a network to calculate all the work, but it 

is also possible to calculate traverses by zones. 

Firstly, go to Utilities > Configuration > Surveying > Least Squares and enable the quality 

control tests, Baarda and Chi2 and leave the other parameters with the default values. 

 

 

 

 Then execute Surveying > Open and select the file NETWORK.LEV in the directory C:\MDT85 
Projects\Tutorial13.    

Enter  Surveying >  Traverses. On the Survey bases list, double click stations 1, 5, 8, 11, 12, 13 

and 6 in this order in such a way as to complete the stations list. You will observe that the box Set Source 

has enabled automatically. Also enable the Closed box and press the Compensate button. 

 

A new dialog will now appear in which we will find the provisional coordinates for the bases and 

the closing error at X,Y,Z and angle. Furthermore, the horizontal and vertical errors eH and eV are shown 

with regard to the length of the traverse. 
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Check that the Calculation Method is under Least Squares and press the Compensate button. 

Check that the coordinates of all the mobile stations have been changed, indicating the displacement 

applied. Under the list it can be observed that the Chi2 test has been passed. 

 

 

 



98 MDT Version  8.5 
 

Press the Distances button in the Observations frame. The final column shows the result of the 

other quality control test selected in the configuration, Baarda test. These results are also shown for the 

other observations. Press OK to close the dialog. 

 

Now press the Print button, leaving the default option enabled and press OK. 

 

In the next dialog specifying the list destination, press .txt button and give as file name 

Compensation Report.txt and open the exported file. 
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Close the notepad and accept the offset dialogs opened, selecting the command Surveying > 

Stations Calculation. Select one of the bases involved in the calculation, for example, 5. Check that in 

addition to the previous coordinates, those produced by the calculation have now been included, also 

indicating the maximum errors in terms of distance and coordinates. 

 

File Summary 

 Once the work has been completed, we list the project files to be found in the directory C:\MDT85 

Projects\Tutorial13. They are as follows: 

 

File Description 
DOLMENES.LEV Survey data in MDT format 
Compensaton Report.txt Traverse compensation report 
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Exercise 14. Geodesic Calculations 

The purpose of this example is to import a points file into the ED50 / UTM 30 system, measured in 

the field using the application TcpGPS and to carry out a transformation of coordinates to insert said 

points into mapping whose coordinates' system is ETRS89 / UTM 30. 

First and foremost, open the file Carto_ETRS89.dwg, which can be found in the directory 
C:\MDT85 Projects\Tutorial14. 

 

Import Points 

Then execute the command Points > Import (or on the options ribbon Points > Creation > 

Import). Set the value of the drawing Scale at 500, press OK  and select the file GPS_ED50.pun in the 

project’s directory. 

 

The following points drawing will be shown: 

 

Apply zoom extension to show the points along with the mapping loaded. It can be observed that 

the points are displaced. 
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Visualization of GPS Raw Data 

The point file is associated with a file of the same name and extension *.GPS which contains 

information about the raw data received at the time when the recording of each point is carried out. This 

data includes the geographic coordinates WGS-84, the number of satellites, the horizontal and vertical 

precisions, the PDOP and the rod height. 

Execute the command Points > List Points (or on the options ribbon Points > Operations > List) 

and press OK in the Points Selection window.  All the available points are selected. 

 

By default, only the points file field are shown: 
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Press the right-hand button of the mouse on the title of the Code column and select Hide Column. 

Follow the same procedure for the column Description in C.Database. 

 

To add the GPS information associated with each point, press the right-hand button of the mouse on 

the title row, select the option Add Fields and mark the fields shown below: 

 

Press OK to view the list of points with the additional information selected 
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Transformation of the Drawing’s Coordinate System 

As explained previously, the points have been taken with GPS in Spain in the coordinates system 

ED50 / UTM 30 . To make the conversion of the WGS84 geographic coordinates which the GPS ends to 

the projected ED50 coordinates, a datum transformation has been deployed based on a grid file with 

NTv2 format published by the National Geographic Institute of said country.  

Execute the command Coordinate Systems > Convert Drawing . 

 

Press the … button of the Origin Coordinates Reference System (Source CRS), enable the Area 

box and select Europe – Spain, pressing the button shown on the right.  
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On the Favourites list, select the ED50-UTM 30 system. The Target CRS is automatically filled in 

with the code 23030 and the transformation of geodesic datums with the code 15932. This is the 

coordinates system used to record the data taken with GPS. Press the OK button. 

 

 

For the target system,  press the … button in the table Target CRS  and from the favourites list 

select the ETRS89-UTM30 system. Check that the 25830 code are automatically filled in for the 

projected CRS and 1149 for the datum transformation. Press OK. 

 

In the frame Elements to be Converted of the conversion dialog, mark Select Layers and press the 

button on the right-hand side: 
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Select the POINTS layer and press OK : 

 

 

Press OK  to convert the drawing and apply the zoom extension. You will observe that the 

coordinates now do match the mapping. 
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Summary of Files 

 Once the job is finished, we list the existing project files in the C:\MDT85 

Projects\Tutorial14 directory. The main files are the following 

 

File  Description 
Carto_ETRS89.dwg Drawing with cartography 
ProyectoGPS_ED50.pun Points file 
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Exercise 15. Image Management 
To perform this exercise, you must have the Image Module.  

Web map services 

For this exercise, we will use the PNOA (National Aerial Orthophoto Plan) web map service, which 

aims to obtain digital aerial orthophotos of all Spanish territory, being a cooperative project and co-

financed between the General State Administration and the Autonomous Communities. 

We have a cartography and a sheet scheme, and will insert the four images needed to cover the 

entire cartography and perform different operations to obtain the final result, using commands to insert, 

paste, georeference, delimit, etc. 

First, we will open Tutorial15.dwg file that we can find in folder C:\MDT85 

Projects\Tutorial15.  

 

Freeze all layers but current one. Then, we insert the four images that cover the whole area, with 

the command Images> Insert WMS Map. If you are asked for a surface file, press the Cancel button. 

In the next dialog box, we select PNOA as our image server, press the button ... and select the 

SRC ETRS89-UTM 30. Then, we choose the Designate window option, we indicate as starting and 

ending points of the upper left sheet with reference to CAD objects and click on the Next button. 
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 A new dialog box shows us the available layers and the different image formats that the server 

offers us, we press the Download Map button, and we obtain the corresponding orthophotograph. 

 

 

 

 

 

 

 

We will repeat this process up to four times to obtain the images corresponding to the four sheets. 

 



 

User Manual 109 

 

 

Combining and delimiting images 

Once we have all the images, we will paste them into one. Run the command Images> Paste images. We 

select the 4 images and choose name and location for the new image, for example Complete.jpg, located in the 

same folder as the current project.  Thaw all layers if desired. 

 

After that, we will delimit an image area. For this, we draw a closed polyline in yellow, unchecking the 

reference to objects around the area of interest, as shown in the figure. You can also insert the block Limits.dwg in 

the same project folder. 

Then we run the command Images> Delimit image, select the image and the drawn polyline and assign it as 

the name Plot.jpg for the new image that is generated. 
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Georeference Image 

Finally, we will georeference the image Cadastre.jpg that we can find in folder C:\MDT85 

Projects\Tutorial15, and that corresponds to a registered plot. Check all the layers again and run the 

command Images> Insert images. 

As there is no georeference, a warning is displayed, and we answer Yes to the question about 

manually specifying the insert parameters. We name a clear point in the drawing and accept the default scale. 

 

 

 

 



 

User Manual 111 

To insert the marks and points that will be part of the georeferencing, we use the following 

sketches: 

 

 

 

To insert the Marks we use the command Images> Marks> Create marks, and we check the 

different marks in the image. 

The points with the same number as the corresponding marks are already inserted in the drawing. 

Otherwise, the command Points> Insert should be used. 

Once we have established the marks and points we use the command Images> Marks> Link from 

Marks to Points, and we are asked to indicate a mark and then we point to the corresponding point, until we 

get all the links that will be part of the georeferencing. 

 

 

Then, run the command Images > Georeference Image and select the image. The following dialog 

box is shown, which allows us to decide the least squares transformation method. In this case, we choose an 

Affine transformation.  
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Press OK, and the application asks for the georeferencing file name of the new image. We validate 

the proposal and press OK, and the calculated transformation will be applied to the image, fitting it onto the 

cartography. 

 

 

File Summary 

Once the work is finished, we list the existing project files in directory C:\MDT85 

Projects\Tutorial15. The main ones are the following: 

 

File Description 
Tutorial15.dwg Original terrain drawing 
Tutorial15.jpg Image 
Tutorial15.jgw Gereference image 
Complete.jpg Image result of joining the 4 original images 
Complete.jgw Georeference file of the image resulting from 

copying the 4 original images 
Plot.jpg Image resulting from delimiting the image 
Plot.jgw Georeference file of the image resulting from 

image delimitation 
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Exercise 16. BIM 

In this exercise, we will make an introduction to the OpenBIM work methodology, and more 

specifically to the IFC exchange format, applied to Civil Engineering. 

We need Professional Version MDT to perform this exercise.  

Exporting topographic surfaces 

Open Terrain.dwg drawing that we can find in folder C:\MDT85 Projects\Tutorial16.  

We now execute the BIM > Export IFC command.  

We first select the Reference System by clicking on the (…) button corresponding to the Site. The 

following window will appear in which we select 25830 : ETRS89 / UTM zone 30N as the Coordinate 

Reference System. 

 

The dialogue box shows that the current surface Terrain.sup has been loaded automatically.  

 

Press OK and write Terrain.IFC as output file name. Then proceed to open the generated file 

with a free viewer, in this case BIM Vision, which can be downloaded from https://bimvision.eu/en/ 

Run the application and select the previously generated file. 

https://bimvision.eu/en/
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Export Earthworks  

Open the Earthworks.dwg drawing that can be found in folder C:\MDT85 Projects\ 

Tutorial16. We note that this is a terrain that has been created with the MDT earthworks commands. 

Then, run the command BIM> Export IFC. Select Version IFC4 and choose in Site section 

Coordinate Reference System 25830: ETRS89 / UTM zone 30N. Delete the Earthworks.sup surface 

that appears by default and press the Surface button. Add the Terrain.sup surface file and then the 

Earhtworks.MT file. The dialog should display the following image: 

 

Press OK and give Earthworks.IFC as output file name. 

We now open the file with BIM Vision. 

If we select the different elements in the objects tree, the properties that have been automatically 

assigned to each of them will be displayed, both for cut and fill areas. 
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Properties and Quantities 

After the earthworks, we will associate a series of properties, which will also be exported in the IFC 

file. 

Initially, all existing properties can be displayed by running the command BIM> Definition of 

Properties Sets. Press the Cancel button to exit without changes. 

 

 

 Then, we assign some of the properties that we have available to the surface. For this, we 

run the command BIM> Assign Properties, select the Earthwork.mt file and assign: 

• Pset_Earthworks-Cut 

• Pset_ Earthworks-Fill 

 



116 MDT Version  8.5 
 

 

 

 If we select each of the property sets, we can visualize the properties assigned to them, with the 

possibility of modifying the Value of any of them, so that they are finally reflected in the IFC file. 

Open the IFC file again with BIM Vision, select some of the 3D solids, and show properties. 

If we click on the Pset_Earthworks-Cut tab, we will observe the Properties associated with the cut 

earthworks. 

 

 

 

Exporting roads 

After that, we will export a surface and a road to an IFC file, to which a series of roadbed layers 

have been previously defined. 

Hence, we open Road.dwg file that we can locate in folder  C:\MDT85 

Projects\Tutorial16. 
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 Then, we will export the information to the BIM model, that is, in this case to the IFC file. For this, 

we run the command BIM > Export IFC, and a window with the current surface will pop up. 

To configure the export, we select SRC 25830 and the IFC4 export version. After that, we press the 

Alignment / Segment button and choose the roadbed.seg file. Finally, press OK and save the 

information in Road.ifc file. 

 

Open the generated file with BIM Vision. You can view both the performed terrain and the 

earthworks, the definition of roadbed layers, etc. Each element has its geometric definition and could also 

contain properties assigned by the user to automatically calculate measurements and budgets and all types 

of reports. 
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Import of horizontal and vertical alignments 

To complete the exercise, we will import an IFC file, in this case a file from the 4x1RC3 version. 

This format revision has the particularity that it can already include axes and grade lines. 

We open onitially a new drawing in CAD and run the command BIM> Import IFC. We select the 

bim4x1rc3.ifc file, and will see the import window with the different project attributes read from the 

file, as well as the content thereof. 

 

We set the same import and drawing settings. By pressing the OK button, it will automatically save 

the files and draw the surface and the imported axis in the current drawing. 
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Summary of Files 

Once the job is finished, we list the existing project files in the C: \MDT85 Projects\Tutorial16 

directory. The main files are the following 

 

File  Description 
Terrain.dwg Drawing of the original terrain 
Earthworks.dwg Drawing of the Earthworks  
Road.dwg Drawing with the definition of the road  
Terrain.sup Original terrain surface 
Earthworks.sup Earthworks surface 
Road.sup Road surface 
Earthworks.mt Earthworks executed 
Roadbed.seg Definition of road 
Bim4x1rc3.ifc IFC file with definition of the road 
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Exercise 17. Networks 

We need Professional Version MDT to perform this exercise.  

 The idea of this exercise is to introduce the user to the MDT Networks module. The different types 

of networks will be managed, in addition to the insertion of nodes and the drawing of pipes. 

 We are going to define two piping networks, one for sewerage and the other for rainwater with their 

corresponding nodes, and finally, using the tools provided by the module, we will represent them in 

elevation mode and calculate the possible existing intersections. 

 First of all, we open the networks.dwg file located in the C:\MDT85 

Projects\Tutorial17 folder. 

 

 We first define the survey surface as current by executing the Surfaces > Current Surface 

command and selecting the surface.sup file. We only draw the boundary line of the surface to 

facilitate the design of the piping sections. 

 The drawing illustrates a number of polylines and points in the SEWERAGE layer and others drawn 

in the RAINWATER layer. 

Creation of Nodes 

 First of all, we are going to create the nodes corresponding to the SEWERAGE network by 

executing the Networks > Create nodes from drawing command, after which a dialogue box will 

appear which we will configure in accordance with the following screenshot. The depth of the node is 

important, and in this case, we are going to establish a depth of 3 meters. On checking the dialogue box, it 

will ask us for the name of the block, and we select SEWERAGE_MANHOLE. 

 

The end result will be as follows, where we have deactivated the layer in which the image is located 

to make the work easier. 
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 Next, we create the nodes for the rainwater network by executing the same command as in the 

previous case, but we now define a value of 2.5 for the depth and select RAINWATER_MANHOLE as 

the name of the rainwater block. 

 

 We hide the NETWORK_SEWERAGE layer and will see all the nodes created automatically. 

 

 

Creation of pipes 

 Once the sewerage and rainwater network nodes have been created, we now create the pipes. Due to 

the fact the creation of the entire network would take us some time, we are going to define, in the case of 

the sewerage network, the pipes corresponding to the polyline in orange. 
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   To do so we execute the Networks > Draw Pipes command, create two piping sections, one for the 

upper polyline and the other for the lower one. The command will ask us for the nodes, and we indicate 

them from right to left. 

 Once the nodes have been designated, the following dialogue box will appear in the upper section, 

which we validate in accordance with the data in it. 

 

 We also execute the lower section.  The end result is illustrated in the screenshot below: 

 

 Moreover, we are going to proceed with the rainwater network, and in this case, we are going to 

create the pipes defined from north to south and with polylines in blue. We will define two pipes, 

designating the nodes from north to south and using same command as in the previous step, Draw pipes. 

 We will accept the values as they appear by default in the definition of the section. The end result is 

illustrated in the screenshot below: 
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Drawing of profiles of pipes 

 Next, we are going to represent the profiles of pipes, and in this case, we are going to represent the 

sewerage network pipe located further north. 

 We then execute the Networks > Draw Profile of Pipe command and select the pipe of the 

sewerage network located further north in the drawing. The following window will appear in which to 

configure the presentation of the profile, and we validate the default values. 

 

 The end result is illustrated in the screenshot below: 
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 Zooming in on node S_34 in the elevation representation will enable us to see the intersection with 

one of the rainwater pipes. 

 

 In order to prevent both pipes overlapping, we edit node S_34 and change its depth to 3.5. To do 

this we execute the Networks > Edit Node command, select the Elevation option, designate the pipe in 

front view and then the node to be edited. 

 The following window will appear in which we change the depth value to 3.5, after which the 

profile will be updated automatically. 

 

 In a similar way, we proceed with the nodes specified below to maintain the downward slope of the 

piping section. 

 If we look for node S_34 on the plane, we will see it has been automatically updated after the 

change in the elevation. 

 Finally, we are going to project one of the networks on some previously generated cross-section 

profiles, which will be very useful for locating the position of the piping network in the cross-sections in 

elevation mode. 

 To do so, we execute the Cross-Sections > Draw Cross-Sections command and select the Cross-

sections.tra file. We then validate the drawing window with the following parameters: 
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 We then execute the Networks > Draw Sections in Cross-sections command, select the section of 

rainwater piping located further East, any of the cross-section alignments and the alignment from which 

the cross-sections have been generated, Alignment1.eje, we can select this file from the example 

folder. The result is as follows: 

 

 

Representation in 3D 

 To end, the network module features a command which enables us to view the defined piping 

network in 3D. We execute the Networks > Draw 3D Network command and the following window will 

appear in which we accept the values proposed by default: 
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If we execute a 3D View in CAD, the 3D representation should be similar to the following image: 

 

Summary of Files 

Once the job is finished, we list the existing project files in the C:\MDT85 Projects\Tutorial17 

directory. The main files are the following 

 

File  Description 
networks.dwg Drawing of the original terrain 
surface.sup Original terrain surface 
Orto.jpg Orthophoto associated with the original 

drawing  
Orto.jgw Georeference of the orthophoto 
Alignment1.eje MDT alignment 
Cross-sections.tra Original surface cross-sections and Alignment 
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Exercise 18. Works Units. Assignment and Measurements 

We need Professional Version MDT to perform this exercise.  

 In this exercise we are going to assign works units to different elements or objects of the project to 

in order to obtain the corresponding measurement lists. 

 We will assign measurements to the following elements: 

• Pavement layers of a road 

• Cut and fill of earthworks. 

• Polyline and block, in this case for an existing fence or an enclosure in the cartography and a 

works block. 

 First of all, we open the Work Units.dwg file located in the C:\MDT85 

Projects\Tutorial18 folder. This drawing already has an associated surface, which is hidden in 

order to facilitate the work. 

 

Settings 

 We are now going to configure the price database with which we are going to work by executing the 

Utilities > Configuration > BIM command. The following dialogue box will appear in which the price 

and life cycle analysis databases need to have been selected. 

 

 If they have not been selected, select the files in the MDT\Config\en\BIM folder. 
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Assignment of works units to pavement layers 

 We are going to work from a predefined segment or road by executing the Templates > Define - 

Edit command and select the Road.seg file. 

 We go to the Roadbeds tab and edit the pavement layers, after which the following configuration 

will appear. 

 

 We select the “B.Mix” layer and click on the Road button in W.Units frame. We assign the work 

unit the code 211.0000. 

 

 We also proceed with the “Art.Ballast” layer and assign it the work unit with code 510.0010. 
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Assignment of works units to earthworks 

 In this case we are going to create a subgrade with the Surfaces > Earthworks > By Platform 

Height command. We select the closed polyline located on the yellow PLATFORM layer. We then 

execute the earthworks with the following configuration. 

 

 Check the Earthwork Vol. box and click on the File button. Then select Volume.MT as the output 

file. 

 We will then see how the controls associated with the works units are enabled, and as in the case of 

pavements, we Select a works unit for Cut and another for Fill. 

 We will assign the works unit with code 320.0020 to cutting zones and the unit with code 330.0020 

filling zones. 



130 MDT Version  8.5 
 

 

Works unit assigned to cutting zones 

Assignment of works units to a polyline and a block 

 First of all, we are going to assign a works unit to a polyline in the drawing by executing the option 

Quantity take-off > Work units > Assignment of work units to entities command, after which we 

select the red polyline in the WALKSIDE layer. The dialogue box for assigning works units will then 

appear. In this case we are going to assign the works unit with code 704.0010, which will represent an 

existing fence or enclosure. 

 

 We will see, when selecting a polyline, that the measurement is applied directly to its Length. 

 The next step, by executing the same command, is to assign a works unit to the block in the right 

area of the drawing in red and located in the TOWERS layer. In this case, we are going to assign works 

unit 920.002, which corresponds to the foundations required for the execution of the work. 
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 In this assignment we check that having detected the block, the program automatically indicates that 

the measurement will be applied to the Unit. 

Generation of Reports 

 Finally, we are going to generate the different reports in accordance with the works units assigned 

to the different objects. 

 When generating reports, the following dialogue box will appear in which we define the objects to 

be calculated. 

 

 Clicking on the “Select" button will enable us to select the segment and the earthworks file 

generated in the previous steps, after which we check the “Entities with assigned Work Units” box  to 

ensure it includes the entities from the drawing to which we have assigned works units. 

Works Units Reports 

We execute the Quantity take-off > Works Units > Road Works Units Report command and select the 

elements to be calculated. The corresponding report will then be calculated. 
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 We can see that the "Work Unit" column is the object to which the works unit has been assigned, 

and the names of the pavement layers, earthworks and objects are displayed. 

Consumption and Emissions Report 

 We execute the Quantity take-off > Works Units > Road Consumption and Emissions Report 

command and a report similar to that in the previous point will be displayed, but in this case it refers to 

the life cycle. 

 Information on measurements will only be displayed for works units with an assigned consumption 

and emission unit. See the Reference Manual in the Measurements section for more details.  

 

 

Budgets 

 As in the previous cases, executing the Quantity take-off > Works Units > Material execution 

budget command will provide a total budget for the works. 

 

 We can see the budget per unit of works and the total, including the price per unit and the 

cummulative total. 

Export to BC3: Exporting the list to BC3 format will enable us to manage this information with 

measurement and budget programs compatible with this format.  

Summary of Files 

Once the job is finished, we list the existing project files in the C:\MDT85 Projects\Tutorial18 

directory. The main files are the following 

 

File  Description 
Work Units.dwg Drawing of the original terrain 
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File  Description 
Work Units.sup Original terrain surface 
Road.seg Definition of the road  
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